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Performance comparison of three Dell XPS 400-series 
systems with various Intel processors 

THE BOTTOM LINE 
 

 The Dell systems with Intel Core 2 Duo 
processors delivered a noticeably better 
computing experience than the Intel 
Pentium D processor 950-based Dell 
system on all tests. 

 The Dell system with the Intel Core 2 Duo 
processor E6700 outperformed the Dell 
system with the Intel Pentium D processor 
950 by as much as 59 percent on a set of 
single-task application scenarios. 

 The Dell system with the Intel Core 2 Duo 
processor E6700 maintained a performance 
edge up to 45 percent over the Intel Pentium 
D processor 950-based Dell system on 
tasks with a background virus scan running. 

 The Dell system with the Intel Core 2 Duo 
processor E6600 outperformed the Dell 
system with the Intel Pentium D processor 
950 by 2 to over 40 percent on a set of 
single-task application scenarios.  

 

Executive summary 
Intel Corporation (Intel) commissioned Principled 
Technologies (PT) to run a set of performance tests on 
the following Dell XPS 400-series desktop systems: 
 

 Dell XPS 400 with an Intel Pentium D processor 
950 

 Dell XPS 410 with an Intel Core 2 Duo processor 
E6600 

 Dell XPS 410 with an Intel Core 2 Duo processor 
E6700 

 
The goal of the testing was to gauge the performance that 
buyers would experience when performing common tasks. 
Dell provided the test systems. PT identified the tests, test 
procedures, and test settings. PT also set up the systems 
and executed all tests.  
 
We used the following industry-standard benchmark to 
gauge performance on common office applications: 
 

 Office productivity, which runs typical office 
applications using BAPCo SYSmark 2004 SE  

 
We created custom tests to measure the performance of 
the following common tasks: 
 

 Photo editing, which opens and edits a group of 
30 digital photos using Adobe Photoshop Elements 4.0 and then prepares a slideshow with background 
music for burning onto a DVD using Adobe Premiere Elements 2.0 

 Photo editing while scanning for viruses, which performs the same photo editing tasks while a virus 
scan runs using Symantec Norton AntiVirus 2006 

 Gaming, which plays a game demo on F.E.A.R. (with Patch 1.06)  
 Gaming while scanning for viruses, which performs the same gaming tasks while a virus scan runs 

using Symantec Norton AntiVirus 2006 
 Music encoding, which uses Apple iTunes 6.0.4 to create mp3 files from wav files 
 Music encoding while scanning for viruses, which performs the same music encoding tasks while a 

virus scan runs using Symantec Norton AntiVirus 2006 
 Video encoding, which converts an .avi file into a streaming video using Windows Media Encoder 9.0 
 Video encoding while scanning for viruses, which performs the same video encoding tasks while a 

virus scan runs using Symantec Norton AntiVirus 2006 
 
Figure 1 summarizes the test results for each custom test running on its own. Each of these results is a relative 
rating of the median of three test results on each system. We calculate this relative comparison by dividing each 
test system’s score by the Intel Pentium D processor 950-based system’s score (the slowest test system in this 
group) for tests in which a higher score is better, and by dividing the Intel Pentium D processor 950-based 
system’s score by the other test system’s score for tests in which a lower score is better. Consequently, 
comparative results above 1.00 indicate tests on which each system outperformed the Intel Pentium D processor 
950-based system, and those below 1.0 indicate tests the Intel Pentium D processor 950-based system won. 
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As Figure 1 shows, the Dell XPS systems with Intel Core 2 Duo processors significantly out-performed the Intel 
Pentium D processor 950. The difference was great enough to represent a tangible, real-life improvement in 
computing experience for the consumer. 
 

 

How our multitasking tests work 
Modern PC users typically perform many tasks at the same time. For example, a virus scan may need to run at 
the same time you need to do some work. Our multitasking tests assess the effect of a secondary, or background, 
task on the task that you're actively performing (the foreground task). Our multitasking scenarios make this 
assessment by running a virus scan in the background and then at the same time running one of the other tests. 
Each multitasking test follows this basic pattern: Scott wants to play F.E.A.R., but his scheduled virus scan is 
running. He's in a quandary. Does he wait for the virus scan to complete? Does he stop the scan in the interest of 
continuing his game? Does his system slow because it has to handle the load of running both the game and a 
virus scan? Or, does he fail to even notice the scan is running because the processor handles both tasks with 
little to no degradation in performance? 
 
Figure 2 presents the relative multitasking results for our three test systems while running a virus scan in the 
background. Figure 3 shows the results for the background antivirus scan running at the same time as each of 
these tests. The Intel Core 2 Duo processor E6700 outperforms the Intel Pentium D processor 950 by amounts 
ranging from 5 to over 60 percent while a Symantec Norton AntiVirus 2006 scan runs in the background. The 
systems with the Intel Core 2 Duo processors handle multiple CPU-intensive tasks while the PC user experiences 
little decrease in performance. 
 
 
 
 
 

Figure 1: Relative single-task results for Dell XPS 400-series systems with various Intel processors on the customized tests.
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Figure 2: Relative foreground task test results for Dell XPS 400-series systems with various Intel processors in multitasking 
scenarios. 
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Figure 3: Relative background task test results for Dell XPS 400-series systems with various Intel processors in multitasking 
scenarios. 
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Figures 2 and 3 both include the BAPCo SYSmark 2004 SE – Office Productivity test results because this test 
incorporates both foreground and background tasks. The results are identical in both figures. 
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The Test results section provides detailed results of these tests. The Test methodology section explains how we 
ran each of these tests. Appendix A provides the details of the system configurations.  

Test results 
Table 1 presents the medians of all test scores for all three systems. (We ran each test three times on each 
system.) In most cases, lower scores are better, because each score is the time the system required to complete 
each workload. A lower time indicates that the system completed the work faster. The two exceptions are in the 
office productivity test (SYSmark 2004 SE – Office Productivity), where a higher score indicates better system 
performance, and in the gaming test (F.E.A.R.), where the higher the frames per second (fps) result indicates 
better gaming graphics performance.  
 

Benchmark or test 
Dell XPS 400 with 
Intel Pentium D 
processor 950  

Dell XPS 410 with 
Intel Core 2 Duo 
processor E6600  

Dell XPS 410 with Intel 
Core 2 Duo processor 
E6700  

Industry-standard benchmark – multitasking workload (higher is better) 
Office productivity test 165 243 252 

Custom tests – single task workloads (lower is better except for gaming test) 
Photo editing test 209 149 137 
Gaming test 51 52 52 
Music encoding test 108 76 68 
Video encoding test 74 55 49 

Custom tests – multitasking workloads 
Photo editing test foreground with virus scanning background (lower is better) 
Photo editing test 222 164 156 
Norton AntiVirus 2006 
scan 460 361 345 

Gaming test foreground with virus scanning background (higher is better for fps; lower is better for 
NAV) 
Gaming test 51 52 53 
Norton AntiVirus 2006 
scan 353 230 250 

Music encoding test foreground with virus scanning background (lower is better) 
Music encoding test 110 78 76 
Norton AntiVirus 2006 
scan 359 223 213 

Video encoding test foreground with virus scanning background (lower is better) 
Video encoding test 77 60 55 
Norton AntiVirus 2006 
scan 333 207 204 

Table 1: Complete median test results for Dell XPS 400-series systems with various Intel processors. 
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Office productivity test (BAPCo SYSmark 2004 SE – Office Productivity) 
Figure 4 presents the relative test results for the office productivity test. The system with the Intel Core 2 Duo 
processor E6700 outperformed the Intel Pentium D processor 950-based system by over 40 percent. This time 
difference translates into a tangible improvement in a consumer’s ability to perform such important tasks as 
working on letters and other documents, developing budgets and other spreadsheets, and surfing the Web with a 
browser. 
 

 
 

Figure 4: Relative performance for Dell XPS 400-series systems on the office productivity test.
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Photo editing test (Adobe Photoshop Elements 4.0 with Adobe Premiere 
Elements 2.0)  
Figure 5 presents the relative performance differences in our photo editing test. The Intel Core 2 Duo processor 
E6700-based system outperforms the system with the Intel Pentium D processor 950 by over 50 percent running 
this test, saving the user almost 30 seconds on the process of creating these slides. Adding the antivirus scan in 
the background has only a slight impact on the performance of the Intel Core 2 Duo processor E6700-based 
system, which still outperforms the system with the Intel Pentium D processor 950 by over 40 percent in this 
multitasking scenario. 
 

 Figure 5: Relative performance for Dell XPS 400-series systems on the photo editing test.
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Gaming test (Sierra Entertainment F.E.A.R. + Patch 1.06) 
Figure 6 presents the relative results for the gaming test using F.E.A.R. on our four test systems. The trend shows 
an increase in performance from the Intel Pentium D processor 950-based system up to the Intel Core 2 Duo 
processor E6700-based system. The system with the Intel Core 2 Duo processor E6700 experienced a relative 
increase in gaming performance with the addition of a virus scan in the background. 
 
 
 

Figure 6: Relative performance for Dell XPS 400-series systems on the gaming test. 
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Figure 7: Relative performance for Dell XPS 400-series systems on the music encoding test. 

Music encoding performance test (Apple iTunes 6.0.4) 
Figure 7 presents the relative results for the music encoding performance test using Apple iTunes 6.0.4. Again we 
see the performance increasing with faster processors. The system with the Intel Core 2 Duo processor E6700 
outperformed the Intel Pentium D processor 950-based system by almost 60 percent when we ran this test alone 
and by over 40 percent when we ran the test with an antivirus scan in the background. This translates into over 30 
seconds of time the user will save on the process of creating this file. 
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Figure 8: Relative performance for Dell XPS 400-series systems on the video encoding test. 

 

Video encoding performance test (Microsoft Windows Media Encoder 9.0 
with Advanced Profiling) 
Figure 8 presents the relative performance results for the video encoding test using Microsoft Windows Media 
Encoder 9.0. The Intel Core 2 Duo processor E6700-based system outperformed the Intel Pentium D processor 
950-based system by 50 percent, a savings of over 20 seconds. In the multitasking scenario, the relative 
performance decreased with the additional virus scan task occurring in the background. 
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Test methodology 
Dell configured and provided all four PCs. This section details the methodologies we followed in testing the 
systems. 

Initial setup 
When the systems arrived, we unpacked and set up each one. We used identical Dell keyboards and mice on the 
systems. We also used identical ViewSonic Optiquest Q7 monitors from our test stock. We went through the 
following process with each PC the first time we booted it: 

Windows XP Media Center 2005 SP2 setup 
We installed on each system a clean version of Windows XP Media Center 2005 Service Pack 2 with updated 
drivers and Windows Updates and re-ran the tests. We went through the following process with each PC for 
installing Windows XP Media Center: 
 

1. Install Windows XP Media Center 2005 with Service Pack 2. 
a. Boot to a Windows XP Media Center 2005 with Service Pack 2 CD. 
b. Press Enter at the Welcome to Setup screen. 
c. Press F8 at the EULA screen. 
d. Select the C: partition, and press Enter. 
e. Click C to continue setup on the C: partition. 
f. Select Format the partition using the NTFS file system (Quick), and press Enter. 
g. Press F to format the selected partition. 
h. Click Next at the Regional and Language Options screen. 
i. Enter a user name into the Name field, leave Organization blank, and click Next. 
j. Enter the Windows XP Media Center 2005 with Service Pack 2 product key, and click Next. 
k. Enter a Computer name, and click Next. 
l. Enter the correct date, time, and time zone area, and click Next. 
m. Select Typical settings, and click Next. 
n. Select Make this computer a member of the following workgroup, leave the default workgroup, and 

click Next. 
o. Click OK to have Windows automatically adjust the screen resolution. 
p. Click OK at the can you see this text at this resolution dialog box. 
q. Click Next at the Welcome to Microsoft Windows screen. 
r. Select Yes, this computer will connect through a local area network or home network, and click Next. 
s. Select Yes, I want to activate Windows over the Internet now, and click Next. 
t. Select No, not at this time to the registering with Microsoft question, and click Next. 
u. Enter User into the Your name field, and click Next. 
v. Click Finish at the Thank you screen. 
w. Select Not right now to Automatic Updates, and click Next. 
x. Select Change the way Security Center alerts me at the Windows Security Center screen. 
y. Uncheck the boxes beside Firewall, Automatic Updates, and Virus Protection Alert Settings, and click 

OK.  
2. Download and install all Critical Windows Updates available as of June 16, 2006.  
3. Set each system’s resolution to 1280 x 1024 x 32-bit color at a refresh rate of 75 Hz. 

 
We used Symantec’s Ghost product to capture an exact image of the hard disk. 
 
Each time we wanted to run a new set of tests on a machine, we used the Ghost image to return that machine to 
the above configuration. After re-imaging, we installed the software necessary to run the test.  
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Office productivity test (BAPCo SYSmark 2004 SE) 
We performed the following steps to run this benchmark: 

Installing SYSmark 2004 SE 
1. Reset the system to the base test image. 
2. Insert the SYSmark 2004 SE DVD, and install with the following default settings: 

a. Click Next at the Welcome to the InstallShield Wizard for SYSmark 2004 SE screen. 
b. At the License Agreement screen, select the I ACCEPT radio button.  
c. Click Next. 
d. Enter User Name, Company Name, and Serial Number at the Customer Information screen.  
e. Click Next. 
f. Click Next at the Destination Directory screen. 
g. Click Next at the Select Program Folder screen. 
h. Select Yes at the Do you want to move the programs to the alternate key screen. 
i. A Setup Status screen will appear and run until the installation is complete. 
j. Select the Yes, I want to restart my computer now radio button. 
k. Remove the disk.  
l. Click Finish. 

3. The system will automatically reboot. 
4. Unplug the network cable. 

Running SYSmark 2004 SE 
1. Launch SYSmark 2004 SE. 
2. Click Run on the left-side menu. 
3. Select Official Run. 
4. Enter a name for the Project Name.  
5. Select three iterations from the drop down menu.  
6. Click OK. 
7. When the benchmark completes, the main SYSmark 2004 SE menu will appear.  
8. Select the Report button, then Official Report, which produces the SYSmark 2004 SE test scores. 
9. At the top, click Disclosure.  
10. Enter all the information the benchmark requires (which the benchmark designates with an asterisk).  
11. Click OK.  
12. When the report appears, click File Export, and designate a location for the benchmark’s Full Disclosure 

Report.  
 
We report the Office Productivity score. Higher scores indicate faster performance and so are better. 

Photo editing test (Adobe Photoshop Elements 4.0 with Adobe Premiere 
Elements 2.0)  
PT created the 30 slide files and the background.mp3 file this test uses. The slide files have the following key 
characteristics: 
 

• Resolution: 3008W x 2000H (180 dpi horizontal x 180 dpi vertical) 
• Size: Range from 399KB (409,220 bytes) to 3,177KB (3,256,320 bytes) 
• Bit depth: 24-bit color 

 
The background.mp3 file has the following key characteristics: 
 

• Length (hh:mm:ss): 00:05:10 
• Size: 5.91 MB (6,202,980 bytes) 
• Creation tool: AudioGrabber Freeware version 1.83 using LAME 3.96. 
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• Encoding rate: 160 Kbits/sec. 
 
We performed the following steps to run this test: 

Installing Photoshop Elements 4.0 with Premiere Elements 2.0 
1. Reset the system to the base test image. 
2. Insert the Adobe Photoshop Elements 4.0 DVD into the system, and choose the following options during 

installation: 
a. Select Language.  
b. Click OK. 
c. Click Accept at the License Agreement screen. 
d. Click Install Adobe Photoshop Elements. 
e. Click Next at the Welcome screen. 
f. Click Accept at the License Agreement screen. 
g. Enter User Name, Organization, and Serial Number (which is on the DVD case).  
h. Click Next. 
i. Click Next at the Destination Folder screen. 
j. At the file types you would like Photoshop Elements to open screen, accept all defaults.  
k. Click Next. 
l. Click Install at the Ready to Install the Program screen. 
m. Click Finish. 
n. Remove the disk from the system. 
o. Click Yes to reboot the system. 

3. Insert the Adobe Premiere Elements 2.0 DVD into the system, and choose the following options during 
installation: 
a. Select Language. 
b. Click OK. 
c. Click Accept at the License Agreement screen. 
d. Click Install Adobe Premiere Elements 2.0. 
e. Select language.  
f. Click OK. 
g. Click Next at the Welcome screen. 
h. Enter User Name, Organization, and Serial Number (which is on the DVD case).  
i. Click Next. 
j. Select NTSC TV Format. 
k. Click Next. 
l. Click Next at the Destination Folder screen. 
m. Click Install at the Ready to Install the Program screen. 
n. Click Finish. 

4.  Launch Photoshop Elements by double-clicking the desktop icon. 
5. Select the Make Photo Creations icon. 
6. Click Register Later at the registration screen. 
7. Uncheck Automatically check for updates every month, and click Cancel. 
8. Click No to the Photoshop Elements Organizer pop up. 

Running the Photoshop Elements 4.0 with Premiere Elements 2.0 performance test 
1. To run this test, you will need a stopwatch. 
2. Copy the 30 slide files and the background.mp3 file into the My Documents directory. 
3. Launch Photoshop Elements by double-clicking the desktop icon. 
4. From the top menu click File->Get Photos->From Files and Folders. 
5. Browse to the My Documents directory. 
6. Select all Slides and uncheck the box next to Automatically Fix Red Eyes. 
7. Click Get Photos. 
8. Check Don’t Show Again, and click OK at the Adobe pop up. 
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9. Select all photos shown by pressing Ctrl-A. 
10. Click the Create button on the top menu. 
11. Select Slide Show to create a slide show, and click OK. 
12. Select 2 seconds for Static Duration and Transition Duration. Set Transition to Fade. Leave other options 

at their defaults, and click OK. 
13. Click the Add Media button, and select the Audio from Folder option. 
14. Browse to My Documents, and click Open on the background.mp3 file. 
15. From the top menu, click File->Save Slide Show Project. 
16. Name the file twofun, and click Save. 
17. Click the Output icon. 
18. Choose Burn to Disc, and select the DVD option. Click OK. 
19. Click Save to create the twofun.wmv file while at the same time starting a stopwatch. 
20. A progress bar will appear. 
21. Stop the stopwatch when the progress bar disappears. 
22. Record this time. 
23. Adobe Premiere Elements 2.0 will automatically launch after Photoshop Elements finishes creating the 

twofun.wmv file. 
24. Click Do Not Register. 
25. Name the New Project PhotoDVD. 
26. Browse to My Videos, and select that directory to define the Save In directory. 
27. Click OK. 
28. Select the Adventure Template; its title is Adventure Main Menu and Adventure Scenes Menu. Premiere 

Elements will automatically select the radio button that says Apply a Template for a DVD with Menus. 
29. Click OK. 
30. Click No at the Missing DVD Markers message. 
31. Click Burn DVD. 
32. Select the Burn to option so it is Folder, and leave the remaining setting at their defaults. 
33. Click Burn while at the same time starting a stopwatch. 
34. A progress bar will appear. 
35. When the progress bar says Export Completed, stop the stopwatch. 
36. Record this time. 
37. Click Close. 
38. Close Adobe Premiere Elements 2.0, and select No to saving changes. 
39. Close the Photoshop Elements Slide Show Editor window.  
40. A pop up message will appear. Check Don’t Show Again, and click OK at the slide show complete dialog. 
41. Right-click the slideshow you just created (the upper left corner photo), and select Delete from Catalog. 
42. Click OK. 
43. Close the Adobe Photoshop 4.0 Organizer window. 
44. Browse to My Documents, and delete the DVD folder you just created.  
45. Click the My Videos folder. 
46. Delete the following two files: output.wmv and PhotoDVD.prel. 
47. Delete the following two folders: Encoded Files and Media Cache Files. 
48. Empty the Recycle Bin. 
49. To calculate the total time this test took, add the time you recorded from the Photoshop Elements portion 

of this test to the time you recorded for the Premiere Elements to complete its task.  
50. Repeat these steps two more times, rebooting between each run. 

 
We report the combined time, in seconds, that Photoshop Elements 4.0 took to convert the files to .wmv format 
with the time that Premiere Elements 2.0 took to burn the contents to a folder. Lower times indicate faster 
performance and so are better. 

How we determined the virus scan workload 
Many of our tests are multitasking scenarios that involve one of our tests as a foreground activity and virus 
scanning as a background. For these tests, we wanted to keep the systems under continuous multitasking 
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workloads, so we wanted a virus-scan workload that ran approximately as long as the longest of the foreground 
tests. We also needed to ensure that each system did the same amount of virus-scan work on each test. To 
accomplish these goals, we created a directory that we scanned in each virus-scanning test. This directory has 
the following characteristics: 
 

• Size: 2.91 GB 
• Number of Files: 17,139 
• Number of Folders: 393 

 
We used this directory for every virus-scan test.  
 
We did not choose to scan the entire hard disk of each system both to keep test time reasonable and to ensure 
that we scanned exactly the same amount of data each time. (Scanning the full hard disk would have yielded 
different workloads depending on which applications were present on the system.) 

Running the Photoshop Elements 4.0 with Premiere Elements 2.0 performance test 
while scanning for viruses with Symantec Norton AntiVirus 2006 
After resetting the systems with the base test images, install the applications in the following order:  
 

1. Photoshop Elements 4.0 with Premiere Elements 2.0. Follow the same set-up instructions as in the 
previous test. 

2. Symantec Norton AntiVirus 2006. Follow the set-up instructions below. 

Installing Symantec Norton AntiVirus 2006 
1. Insert Norton AntiVirus 2006 CD. 
2. Click Install Norton AntiVirus. 
3. Click Next > at Norton AntiVirus Setup dialog box. 
4. Select I accept the License Agreement, and enter the product key at the License dialog box. 
5. Click Next >. 
6. Click Start Scan at the Active Applications Detected dialog box. 
7. Click Next > at the Preinstall Checkup dialog box. 
8. Click Next > at the Select the destination folder dialog box. 
9. At the completion of Norton AntiVirus Setup, select the Restart Windows Now (recommended) radio 

button if Norton AntiVirus has not already selected it by default, and click the Finish button. 
10. After the system reboots, click the Next button on the Norton AntiVirus splash screen. 
11. Click Next at the Activation dialog box. 
12. Click Next at the Security dialog box. Accept the default to allow Norton AntiVirus to turn off redundant 

Windows Security Center Alerts. 
13. Click Finish to run LiveUpdate and perform a full system scan. 
14. Click Next > at the LiveUpdate dialog box to run LiveUpdate. 
15. Click Next > to install the updates LiveUpdate downloads. 
16. Click Finish at the end of update installation. 
17. If Norton AntiVirus suggests a reboot, reboot the system. 
18. After the reboot, launch Norton AntiVirus by double-clicking the desktop icon. 
19. Copy the Virus Workload directory to My Documents. 
20. Choose Scans from the options on the left panel in Norton AntiVirus. 
21. Choose Create custom scan. 
22. Click Next >. 
23. Click Add folders button. 
24. Browse to the Virus Workload directory in My Documents. 
25. Select the Virus Workload directory, and click the Add button. 
26. Click Next >. 
27. Enter the Scan name: Virus_workload. 
28. Click Finish. 
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Running the test 

1. Copy the 30 slides and the background.mp3 into the My Documents directory. 
2. Launch Norton AntiVirus by double-clicking the desktop icon. 
3. Choose Scans from the left panel in Norton AntiVirus. 
4. Launch Photoshop Elements by double-clicking the desktop icon. 
5. From the top menu click File->Get Photos->From Files and Folders. 
6. Browse to the My Documents directory. 
7. Select all Slides and uncheck the box next to Automatically Fix Red Eyes. 
8. Click Get Photos. 
9. Check Don’t Show Again, and click OK at the Adobe pop up. 
10. Select all photos shown by pressing Ctrl-A. 
11. Click the Create button on the top menu. 
12. Select Slide Show to create a slide show, and click OK. 
13. Select 2 seconds for Static Duration and Transition Duration. Set Transition to Fade. Leave other options 

at their defaults, and click OK. 
14. Click the Add Media button, and select the Audio from Folder option. 
15. Browse to My Documents, and click Open on the background.mp3 file. 
16. From the top menu, click File->Save Slide Show Project. 
17. Name the file twofun, and click Save. 
18. Click the Output icon. 
19. Choose Burn to Disc, and select the DVD option. Click OK. 
20. In Norton AntiVirus, click the Virus_workload custom scan to start the Norton AntiVirus scan. 
21. In Photoshop Elements, click Save to create the twofun.wmv file while at the same time starting a 

stopwatch. 
22. A progress bar will appear. 
23. Stop the stopwatch when the progress bar disappears. 
24. Record this time. 
25. Adobe Premiere Elements 2.0 will automatically launch after Photoshop Elements finishes creating the 

twofun.wmv file. 
26. Name the New Project PhotoDVD. 
27. Browse to My Videos, and select that directory to define the Save In directory. 
28. Click OK. 
29. Select the Adventure Template; its title is Adventure Main Menu and Adventure Scenes Menu. Premiere 

Elements will automatically select the radio button that says Apply a Template for a DVD with Menus. 
30. Click OK. 
31. Click No at the Missing DVD Markers message. 
32. Click Burn DVD. 
33. Select the Burn to option so it is Folder, and leave the remaining setting at their defaults. 
34. Click Burn while at the same time starting a stopwatch. 
35. A progress bar will appear. 
36. When the progress bar says Export Completed, stop the stopwatch. 
37. Record this time. 
38. Click Close. 
39. The virus scan is complete when a dialog box appears stating Scan Complete. 
40. Click the Finish button in this dialog box. 
41. Select Reports from the left panel in Norton AntiVirus. 
42. Click View Activity Log. 
43. Select Norton AntiVirus/Application activities in the Log Viewer. 
44. Norton AntiVirus displays the Scan Time in minutes and seconds. 
45. Record this time. 
46. Close the Log Viewer. 
47. Close Norton AntiVirus. 
48. Close the Photoshop Elements Slide Show Editor window.  
49. A pop up message will appear. Check Don’t Show Again, and click OK at the slide show complete dialog. 
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50. Right-click the slideshow you just created (the upper left corner photo), and select Delete from Catalog. 
51. Click OK. 
52. Close the Adobe Photoshop 4.0 Organizer window. 
53. Browse to My Documents, and delete the DVD folder you just created.  
54. Click the My Videos folder. 
55. Delete the following two files: output.wmv and PhotoDVD.prel. 
56. Delete the following two folders: Encoded Files and Media Cache Files. 
57. Empty the Recycle Bin. 
58. To calculate the total time this test took, add the time you recorded from the Photoshop Elements portion 

of this test to the time you recorded for the Premiere Elements to complete its task.  
59. Repeat these steps two more times, rebooting between each run. 

 
We report the combined time, in seconds, that Photoshop Elements 4.0 took to convert the files to .wmv format 
with the time that Premiere Elements 2.0 took to burn the contents to a folder. We also report the time Norton 
AntiVirus took to complete its scan. Lower times indicate faster performance and so are better. 

Gaming test (SIERRA Entertainment F.E.A.R. + Patch 1.06) 
We performed the following steps to run this test: 

Installing F.E.A.R. + Patch 1.06 
1. Reset the system to the base test image. Make sure the system is not connected to the Internet. 
2. Insert the F.E.A.R. DVD. 
3. Click Install. 
4. Click Next at the InstallShield Wizard screen. 
5. Scroll down to the end of the EULA and click the radio button to accept terms of the agreement. 
6. Click Next. 
7. Enter validation code. 
8. Click Next. 
9. Click Next at the Destination Location screen. 
10. Click Next. 
11. Select Yes when the installation software prompts you to install DirectX 9.0c. Clicking No will abort the 

installation. 
12. Click Install. 
13. An installation screen will appear. 
14. Select the radio button next to “No, install GameSpy Arcade later.” 
15. Click Next. 
16. Uncheck the box to register F.E.A.R. 
17. Click Finish. 
18. Plug in the network cable. 
19. Double click on the F.E.A.R. desktop icon. 
20. A screen will appear asking you whether you would like to get the updated version of F.E.A.R.  
21. Click Yes. 
22. When the FilePlanet Download Helper screen appears, click Download. 
23. A pop-up window will warn you about malicious scripts; click Unblock. 
24. Once the FilePlanet Download Helper completes, an InstallShield Wizard for F.E.A.R. v. 1.05 Update will 

appear. 
25. Click Next. 
26. Click Yes at the License Agreement screen. 
27. Click Finish at the Maintenance Completion screen. 
28. Download and install patch 1.06. 

Setting up F.E.A.R. 
Intel specified the F.E.A.R. setup and test parameters. We set them with the following process: 
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1. Double click on the F.E.A.R. desktop icon. 
2. Click Options. 
3. Click Display, and make the following changes: 

• Resolution: 1024 x 768 
• VSync: Off 

3. Click Performance -> Advanced Computer Options  
• For Physics, set the following: 

o MultiPlayer Physics: Maximum 
o Single Player Physics: Maximum 

• For Effects, set the following: 
o Particle Bouncing: Maximum 
o Shell Casings: Maximum 
o World Detail: Maximum 
o Corpse Detail: Maximum 

4. Click Advanced Video Card Options 
• For Effects, set the following: 

o Effects Detail: Medium 
o Model Decals: Medium 
o Water Resolution: Medium 
o Reflection and Displays: Medium 
o Volumetric Lights: Off 
o Volumetric Light Density: Medium 

• For Graphics, set the following: 
o FSAA: Off 
o Light Detail: Medium 
o Enable Shadows: On 
o Shadow Detail: Medium 
o Soft Shadows: Off 
o Texture Filtering: Trilinear 
o Texture Resolution: Medium 
o Videos: Medium 
o Pixel Doubling: Off 
o DX8 Shaders: Off 
o Screen Resolution: 1024x768 
o Shaders: Medium 

Running the F.E.A.R. performance test 
1. Double click the F.E.A.R. desktop icon to launch the game. 
2. Click Options  Performance  Test setting. This will automatically launch the performance test demo. 
3. Once the demo completes, it displays its results in frames per second (fps). It shows the minimum, 

average, and maximum fps. 
4. Record the average fps. 
5. Click OK. 
6. Click Back. 
7. Click Back. 
8. Click Quit. 
9. Click Yes when the game asks if you are sure you want to quit. 
10. Reboot the computer, and repeat these steps two times. 

Running the F.E.A.R. performance test while scanning for viruses with Symantec 
Norton AntiVirus 2006 
After resetting the systems with the base test images, install the applications in the following order:  
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1. SIERRA Entertainment F.E.A.R. Follow the same set-up instructions as in the previous test. 
2. Symantec Norton AntiVirus 2006. Follow the same set-up instructions as in the previous test that includes 

virus scanning. 
 
Running the test 

1. Launch Norton AntiVirus by double-clicking the desktop icon. 
2. Choose Scans from the left panel in Norton AntiVirus. 
3. In Norton AntiVirus, click the Virus_workload custom scan to start the Norton AntiVirus scan. 
4. Launch F.E.A.R. 
5. At the main F.E.A.R. menu, click Options Performance Test setting. This will automatically launch the 

performance test demo. 
6. Once the demo completes, it displays its results in frames per second (fps). It shows the minimum, 

average and maximum fps. 
7. Wait until the virus scan completes. The virus scan is complete when a dialog box appears stating Scan 

Complete. 
8. Record the average fps in F.E.A.R. 
9. Click OK. 
10. Click Back. 
11. Click Back. 
12. Click Quit. 
13. Click Yes when the game asks if you are sure you want to quit. 
14. Click the Finish button in the Norton AntiVirus dialog box that states the scan is complete. 
15. Select Reports from the left panel in Norton AntiVirus. 
16. Click View Activity Log. 
17. Select Norton AntiVirus/Application activities in the Log Viewer. 
18. Norton AntiVirus displays the Scan Time in minutes and seconds. 
19. Record this time. 
20. Close the Log Viewer. 
21. Close Norton AntiVirus. 
22. Reboot the system, and repeat these steps two times. 

 
We report the average FPS result that the performance test demo produces. Higher FPS rates indicate faster 
graphics performance and so are better. We also report the time Norton AntiVirus took to complete its scan. 
Lower times indicate faster performance and so are better. 

Music encoding test (Apple iTunes 6.0.4) 
PT created the file, PTmixTest.wav, this test uses. The file has the following key characteristics: 
 

• Length (hh:mm:ss): 01:07:13 
• Size: 678 MB (711,491,806 bytes) 
• Source: Pearl Jam’s Rear View Mirror Music CD 
• Creation tool: Magix MP3 Maker 2005 Deluxe. 
 

We performed the following steps to run this test: 

Installing iTunes 6.0.4 
1. Reset the system to the base test image. 
2. Download iTunes 6.0.4 from http://www.apple.com/itunes/download/.  
3. Launch the iTunes installer with setup defaults. 

a. Choose Setup Language.  
b. Click OK. 
c. Click Next at the Welcome to iTunes 6 Installer screen. 
d. Select the I accept the terms of the license agreement radio button. 
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e. Click Next. 
f. Click Next at the About iTunes screen. 
g. Accept all defaults. 
h. Click Next at the Setup Type screen. 
i. Click Next at the Choose Destination Location screen. 
j. Click Next at the Born to be together screen. 
k. Click Finish at the Installation Successful screen. 

4. Copy the PTmixTest.wav file to My Music. 
5. Launch iTunes via its desktop icon. 
6. Click Agree at the License Agreement. 
7. Click Next at the Welcome to iTunes screen. 
8. Uncheck the Add MP3 and AAC files option. 
9. Uncheck the Add WMA files option, and click Next. 
10. Choose No, I’ll change the file and folder names myself, and click Next at the Keep iTunes Music Folder 

Organized screen. 
11. Choose No, take me to my iTunes Library, and click Finish at the iTunes Music Store screen. 
12. Under the Edit menu, select Preferences. 
13. Click the Advanced tab. 
14. Click the Importing tab. 
15. From the drop-down menu next to Import Using, choose MP3 Encoder. 
16. Uncheck Play songs while importing. 
17. Uncheck Create filenames with track number. 
18. Click OK. 
19. Exit iTunes. 
20. Reboot the system. 

Running the iTunes 6.0.4 performance test 
1. Launch iTunes via its desktop icon. 
2. From the file menu, select Add File to Library. 
3. Browse to the My Music directory, and choose the test file (PTmixTest.wav) to add to the library. 
4. Click Open after you select the file. 
5. iTunes will now show this file in its song-list pane. 
6. Right-click the file, and select the option Convert Selection to MP3. 
7. During the encoding process, iTunes shows that it is creating a new PTmixTest file with an Incomplete in 

the Time column beside that file. 
8. When the converting progress bar disappears, iTunes has finished the encoding. 
9. Use Windows Explorer to locate the output PTmixTest.mp3 file in the iTunes directory within the My 

Music folder. 
10. Right-click the file, and choose Properties. 
11. Calculate the difference between the file Created and Modified times. This time is how long iTunes took to 

encode the file to .mp3 format. 
12. Highlight the two PTmixTest items in the iTunes Library. 
13. Right click, and select Clear. 
14. Check the box that says Do not ask me again, and click Remove. 
15. Click Move to Recycle Bin. 
16. Empty the Recycle Bin. 
17. Repeat two times. 

 
We report the time, in seconds, that iTunes took to convert the file. The time we report is the difference of the file 
creation and modification times. Lower times indicate faster performance and so are better. 

Running the iTunes 6.0.4 performance test while scanning for viruses with Symantec 
Norton AntiVirus 2006 
After resetting the systems with the base test images, install the applications in the following order:  



 
20 

 
 

Principled Technologies, Inc.: Performance comparison of  
Dell XPS 400-series systems with various Intel processors 

 
1. Apple iTunes 6.0.4. Follow the setup same instructions as in the previous test. 
2. Symantec Norton AntiVirus 2006. Follow the same set-up instructions as in the previous tests that include 

virus scanning. 
 

Running the test 
1. Launch Norton AntiVirus by double-clicking the desktop icon. 
2. Choose Scans from the left panel in Norton AntiVirus. 
3. Launch iTunes by double-clicking the desktop icon. 
4. From the file menu, select Add File to Library. 
5. Browse to the My Music directory, and choose the test file (PTmixTest.wav) to add to the library. 
6. Click Open after you select the file. 
7. iTunes will now show this file in its song-list pane. 
8. In Norton AntiVirus, click the Virus_workload custom scan to start the Norton AntiVirus scan. 
9. In iTunes, right-click the file showing in the song-list pane, and select the option Convert Selection to 

MP3. 
10. During the encoding process, iTunes shows that it is creating a new PTmixTest file with an Incomplete in 

the Time column beside that file. 
11. When the converting progress bar disappears, iTunes has finished the encoding. The virus scan is 

complete when a dialog box appears stating Scan Complete. 
12. Click Finish button in this dialog box. 
13. The virus scan is complete when a dialog box appears stating Scan Complete. 
14. Click the Finish button in this dialog box. 
15. Select Reports from the left panel in Norton AntiVirus. 
16. Click View Activity Log. 
17. Select Norton AntiVirus/Application activities in the Log Viewer. 
18. Norton AntiVirus displays the Scan Time in minutes and seconds. 
19. Record this time. 
20. Close the Log Viewer. 
21. Close Norton AntiVirus. 
22. Use Windows Explorer to locate the output PTmixTest.mp3 file in the iTunes directory within the My 

Music folder. 
23. Right-click the file, and choose Properties. 
24. Calculate the difference between the file Created and Modified times. This time is how long iTunes took to 

encode the file to .mp3 format. 
25. Highlight the two PTmixTest items in the iTunes Library. 
26. Right click, and select Clear. 
27. Check the box that says Do not ask me again, and click Remove. 
28. Click Move to Recycle Bin. 
29. Empty the Recycle Bin. 
30. Repeat two times. 

 
We report the time, in seconds, that iTunes took to convert the file. The time we report is the difference of the file 
creation and modification times. We also report the time Norton AntiVirus took to complete its scan. Lower times 
indicate faster performance and so are better. 

Video encoding test (Microsoft Windows Media Encoder 9.0 with Advanced 
Profiling) 
PT created the file, test.avi, this test uses. Copy this file to the My Videos directory. The file has the following key 
characteristics: 
 

• Length (mm:ss): 2:00 
• Size: 1.25 GB (1,347,503,818 bytes) 
• Video resolution: 640x480 
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We performed the following steps to run this test: 

Installing Microsoft Media Player 10 
1. Reset the system to the base test image. 
2. Download Microsoft Media Player 10 from Microsoft’s Web site 

(http://www.microsoft.com/windows/windowsmedia/mp10/default.aspx).  
3. Use this executable to upgrade the installed player from version 9 to version 10, which the test requires.  

a. At the License Agreement screen, click I Accept. 
b. At the Confirm software download license agreement screen, click I Accept. 
c. At the Welcome screen, click Next. 
d. At the Select Your Privacy Options, accept all default settings, and click Next. 
e. Accept all default file associations, and click Finish. 
f. Answer No to the question Do you want to search your computer for files that have not been added to 

the library yet. 
4. Close Windows Media Player 10. 
5. Reboot the system. 

Installing Windows Media Encoder 9.0 
1. Download Microsoft Windows Media Encoder 9.0 from Microsoft’s Web site 

(http://www.microsoft.com/windows/windowsmedia/9series/encoder/default.aspx), and store this file in the 
C:\ directory. 

2. Using Windows Explorer, navigate to the downloaded Microsoft Windows Media Encoder 9.0 installation 
executable file, and double-click it. 

3. At the Welcome screen, click Next. 
4. Accept the License Agreement, and click Next. 
5. Accept the default installation folder, and click Next. 
6. Click Install to begin the installation process. 
7. When the installation completes, click Finish. 
8. Reboot the system. 

Running the Windows Media Encoder 9.0 performance test 
1. Start Windows Media Encoder 9.0 by clicking Start Programs Windows Media Windows Media 

Encoder.  
2. Highlight Custom Session, and click OK.  
3. In the Sources tab, click the File radio button from the choices for Source from.  
4. Click the Browse button, and navigate to the My Videos directory. 
5. Highlight the test.avi file, and click OK.  
6. Click the Output tab.  
7. Uncheck the box next to Pull from encoder in the center of the screen.  
8. Check the box next to Encode to file towards the bottom of the screen. 
9. Type Output in the File name box. 
10. Click the Compression tab.  
11. Click Edit… towards the top right corner of the window. The Custom Encoding Settings dialog will open. 
12. In the Media Types section, select Windows Media Video 9.0 Advanced Profile next to Video. Click OK. 
13. Click Apply. A dialog will appear stating that the program has renamed the output file with a new 

extension. 
14. Click OK. 
15. The main window will appear.  
16. Click the green Start Encoding button at the top of the screen. The green progress bar at the bottom right 

of the screen will show the status of the encoding process. 
17. When the encoding process is complete, an Encoding Results window will appear. 
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18. The fifth line shows the Session Duration, which is the time the application took to complete the 
conversion. Record this time as the test’s result.  

19. Click Close. 
20. Close Windows Media Encoder.  
21. Click No. 
22. Using Windows Explorer, find and delete the output.wmv file from the My Videos directory. 
23. Empty the Recycle Bin. 
24. Repeat two times. 

 
We report the time, in seconds, that Windows Media Encoder took to process the AVI file. The time we report is 
the session duration that Windows Media Encoder displays. Lower times indicate faster performance and so are 
better. 

Running the Windows Media Encoder 9.0 performance test while scanning for viruses 
with Symantec Norton Antivirus 2006 
After resetting the systems with the base test images, install the applications in the following order:  
 

1. Microsoft Media Player 10. Follow the same set-up instructions as in the previous test. 
2. Microsoft Windows Media Encoder 9.0. Follow the same set-up instructions as in the previous test. 
3. Symantec Norton AntiVirus 2006. Follow the same set-up instructions as in the previous tests that include 

virus scanning. 
 
Running the test 

1. Start Windows Media Encoder 9.0 by clicking Start Programs Windows Media Windows Media 
Encoder.  

2. Highlight Custom Session, and click OK.  
3. In the Sources tab, click the File radio button from the choices for Source from.  
4. Click the Browse button, and navigate to the My Videos directory. 
5. Highlight the test.avi file, and click OK.  
6. Click the Output tab.  
7. Uncheck the box next to Pull from encoder in the center of the screen.  
8. Check the box next to Encode to file towards the bottom of the screen. 
9. Type Output in the File name box. 
10. Click the Compression tab.  
11. Click Edit… towards the top right corner of the window. The Custom Encoding Settings dialog will open. 
12. In the Media Types section, select Windows Media Video 9.0 Advanced Profile next to Video. Click OK. 
13. Click Apply. A dialog will appear stating that the program has renamed the output file with a new 

extension. 
14. Click OK. 
15. The main window will appear.  
16. Launch Norton AntiVirus by double-clicking the desktop icon. 
17. Choose Scans from the left panel in Norton AntiVirus. 
18. In Norton AntiVirus, click the Virus_workload custom scan to start the Norton AntiVirus scan. 
19. In Windows Media Encoder, click the green Start Encoding button at the top of the screen. The green 

progress bar at the bottom right of the screen will show the status of the encoding process. 
20. When the encoding process is complete, an Encoding Results window will appear. 
21. The fifth line shows the Session Duration, which is the time the application took to complete the 

conversion. Record this time as one of the test’s results. 
22. The virus scan is complete when a dialog box appears stating Scan Complete. 
23. Click the Finish button in this dialog box. 
24. Select Reports from the left panel in Norton AntiVirus. 
25. Click View Activity Log. 
26. Select Norton AntiVirus/Application activities in the Log Viewer. 
27. Norton AntiVirus displays the Scan Time in minutes and seconds. 
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28. Record this time. 
29. Close the Log Viewer. 
30. Close Norton AntiVirus. 
31. Close Windows Media Encoder. 
32. Using Windows Explorer, find and delete the output.wmv file from the My Videos directory. 
33. Empty the Recycle Bin. 
34. Repeat two times. 

 
We report the time, in seconds, that Windows Media Encoder took to process the AVI file. The time we report is 
the session duration that Windows Media Encoder displays. We also report the time Norton AntiVirus took to 
complete its scan. Lower times indicate faster performance and so are better. 
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Appendix A – System Disclosures 
This appendix provides detailed configuration information about each of the test PCs. 
 

System 
Dell 

XPS 400 
Intel Pentium D 950 

Dell 
XPS 410 

Intel Core 2 Duo E6600 

Dell 
XPS 410 

Intel Core 2 Duo E6700 
General    
Processor and OS kernel: 
(physical, core, logical) / 
(UP, MP) 

1P2C2L / MP 1P2C2L / MP 1P2C2L / MP 

Number of physical 
processors 1 1 1 

Single/Dual-core 
processors Dual-Core Dual-Core Dual-Core 

HT Enabled/Disabled NA NA NA 
System Power 
Management Policy Home/Office Desk Home/Office Desk Home/Office Desk 

CPU    
System type Desktop Desktop Desktop 
Vendor Intel Intel Intel 
Name Pentium D 950 Intel Core 2 Duo E6600 Intel Core 2 Duo E6700 
Stepping 2 5 5 
Socket type LGA775 LGA775 LGA775 
Core frequency (GHz) 3.4 2.4 2.66 
Front-side bus frequency 
(MHz) 800 1066 1066 

L1 Cache 16 KB + 12 Kµops 32 KB + 32 KB 32 KB + 32 KB 
L2 Cache 4 MB (2 MB per core) 4 MB (Shared) 4 MB (Shared) 
Platform    
Vendor and model 
number 

Dell XPS 400 desktop 
system 

Dell XPS 410 desktop 
system 

Dell XPS 410 desktop 
system 

Service Tag Number 1BTG581 0510054 0426956 
Motherboard model 
number 

Dell 
0YC523 Dell DXP061 Dell DXP061 

Motherboard chipset Intel i945 Intel i965 Intel i965 
Motherboard revision 
number 00 AA-D57327-200 AA-D37032-201 

Motherboard serial 
number 

4C4C4544-54100042-
C0B14780-3138354F 

CN-0WG855-70821-64O-
0002 

CN-0WG855-70821-64E-
000L 

BIOS name and version Dell A05 Dell 0.1.17 Dell 0.1.17 
BIOS settings Default Default Default 
Chipset INF driver Intel 8.0.1.1002 Intel 8.0.1.1002 Intel 8.0.1.1002 
Memory module(s)    
Vendor and model 
number 

Infineon 
64T64000HU3SA 

Infineon 
64T64000HU3SA 

Infineon 
64T64000HU3SA 

Type PC2-5300 PC2-5300 PC2-5300 
Speed (MHz) 667 667 667 
Speed in the system 
currently running @ 
(MHz) 

333 333 333 
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Timing/Latency (tCL-
tRCD-tRP-tRASmin) 5-5-5-15 5-5-5-15 5-5-5-15 

Size 1024 MB 1024 MB 1024 MB 
Number of sticks 2 x 512 MB 2 x 512 MB 2 x 512 MB 
Chip organization Single-sided Single-sided Single-sided 
Channel Dual Dual Dual 
Hard disk    
Vendor and model 
number Seagate ST380013AS Samsung HD080HJ/P Western Digital 

WD800JD-75MSA1 
Number of disks in 
system 1 1 1 

Size 80 GB 80 GB 80 GB 
Buffer Size 8 MB 8 MB 8 MB 
RPM 7200 7200 7200 
Type SATA 150 Mb/s SATA 300 Mb/s SATA 300 Mb/s 
Controller Intel 82801GB (ICH7) Intel 82801HB (ICH8) Intel 82801HB (ICH8) 
Driver Intel 5.1.0.1022 Intel 8.0.0.1008 Intel 8.0.0.1008 
Operating system    

Name 
Microsoft Windows XP 

Media Center 2005 
Edition 

Microsoft Windows XP 
Media Center 2005 

Edition 

Microsoft Windows XP 
Media Center 2005 

Edition 
Build number 2600 2600 2600 
Service pack 2 2 2 
Microsoft Windows 
update date 06/16/2006 06/16/2006 06/16/2006 

File system NTFS NTFS NTFS 
Kernel ACPI Multiprocessor PC ACPI Multiprocessor PC ACPI Multiprocessor PC 
Language English English English 
Microsoft DirectX version DirectX 9.0c DirectX 9.0c DirectX 9.0c 
Graphics    
Vendor and model 
number NVIDIA GeForce 6800 NVIDIA GeForce 6800 NVIDIA GeForce 6800 

Chipset GeForce 6800 GeForce 6800 GeForce 6800 
BIOS version 5.41.02.34.05 5.41.02.34.05 5.41.02.34.05 
Type PCI-E PCI-E PCI-E 
Memory size 256 MB 256 MB 256 MB 

Resolution 1280 x 1024 x 32-bit color 
(75Hz) 

1280 x 1024 x 32-bit color 
(75Hz) 

1280 x 1024 x 32-bit color 
(75Hz) 

Driver NVIDIA 8.4.2.1 NVIDIA 8.4.2.1 NVIDIA 8.4.2.1 
Sound card/subsystem    
Vendor and model 
number 

SigmaTel High Definition 
Audio 

SigmaTel High Definition 
Audio 

SigmaTel High Definition 
Audio 

Driver SigmaTel 5.10.0.4823 SigmaTel 5.10.0.4823 SigmaTel 5.10.0.4823 
Network 
card/subsystem    

Vendor and model 
number Intel PRO/1000 PL Intel 82566DC Gigabit Intel 82566DC Gigabit 

Type Integrated Integrated Integrated 
Driver Intel 9.0.15.0 Intel 9.4.6.0 Intel 9.4.6.0 
Other Network Card 
Information N/A N/A N/A 
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Optical drive 1    
Vendor and model 
number SONY DDU1615S NEC ND-3650A NEC ND-3650A 

Type DVD-ROM DVD-RW DVD-RW 
Interface Internal SATA Internal SATA Internal SATA 
Dual/Single layer N/A Dual Dual 
Optical drive 2    
Vendor and model 
number Hitachi GCE-8487B N/A N/A 

Type CD-RW N/A N/A 
Interface Internal SATA N/A N/A 
Dual/Single layer N/A N/A N/A 
USB ports    
# of ports 7 (2 front, 5 back) 8 (2 front, 6 back) 8 (2 front, 6 back) 
Type of ports (USB1.1, 
USB2.0) 2.0 2.0 2.0 

Figure 9: Detailed configuration information for the desktop PCs. 
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TESTING, HOWEVER, PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR 
IMPLIED, RELATING TO THE TEST RESULTS AND ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING 
ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE. ALL PERSONS OR ENTITIES RELYING ON THE 
RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED TECHNOLOGIES, INC., ITS 
EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR DAMAGE 
ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.  
 
IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES IN CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC.’S LIABILITY, INCLUDING FOR DIRECT DAMAGES, EXCEED THE 
AMOUNTS PAID IN CONNECTION WITH PRINCIPLED TECHNOLOGIES, INC.’S TESTING. CUSTOMER’S SOLE AND EXCLUSIVE 
REMEDIES ARE AS SET FORTH HEREIN. 
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